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Unsupervised Classification
Clustering
Mac Tutorial

A Beginning Note: The MultiSpec© software is an ongoing project of the Laboratory
for Applications of Remote Sensing, at Purdue University. Developed by David
Landgrebe and programmed by Larry Biehl, the software was originally written for the
Macintosh platform. The software has been converted to the Windows platform and a PC
tutorial is available separately. All recent versions of MultiSpec© for Macintosh
computers will perform the activitiesin this tutorial. However, this tutorial is based on
the May 2001 release of the software, and has been revised for that version. Those
wishing to upgrade their software to the newest version should visit the Purdue website at

http://dynamo.ecn.purdue.edu/~biehl/Multi Spec
and download the newest release. All users are encouraged to visit the Purdue website
periodically for information on updated versions of the software.
To use thistutorial, you will need the Beverly.lan image used in GLOBE training, and an

image file named beverly.clu. These are available from the GLOBE Program web site,
or they may be downloaded from the University of New Hampshire site at:

http://www.globe.unh.edu

Follow the link to "MultiSpec Tutorials'

Note: To obtain the best performance from MultiSpec©, you should use your Control
Panels to set your monitor display to “thousands’ or “millions’ of colors.



Unsupervised Classification
“Clustering”
MultiSpec© PC

Each pixel in your LandSat TM image contains a wealth of information about the surface
materials that reflected light from that pixel to the satellite sensors. Each pixel contains a
reflectance value that can range from 0 to 255 for each TM band supplied with your
image. If, for example, your image contains data for five bands, then each pixel contains
five pieces of data, each potentially ranging from 0 to 255, as shown in the sample pixel
diagram below.

Landsat Pixel

Band 1 Blue 39
Band 2 Green a3
Band 3 Red 25

Band 4 Near IR 149
Band 5 Mid IR 72

30 m

This means that your image could contain 256 > (that’s approximately 1.1 billion)
different possible spectral combinations. Each of these combinations does not represent a
different type of land cover; most of these variations represent very small and, to us,
“unseeable” differencesin surface conditions.

In most instances, your computer monitor will be displaying only afew thousand
colors, hence afew thousand different pixels. Even set to “millions’ of colors, only a
small part of the many different pixels can be displayed. Even if amonitor could display
all the different possible pixels, your eyes could recognize only a small number of
differencesin their appearance.

Because there is a limited number of different land cover types (the Modified
UNESCO Classifications System, MUC, contains about 170 different types), and no
GLOBE study site will have more than afew of these different land cover types, it is
desireable to group pixels together into a smaller number of closely related “ classes.”
This process, whereby pixels with similar spectral characteristics are grouped, is called
“Classification,” and is done in two different ways.

In asupervised classification, you “train” the software to recognize that certain
types of pixels represent specific land cover types. Thisis done on the basis of your



knowledge of your own area, and fieldwork you may do. The software then classifies the
pixels of your image into the groups you have specified.

In an unsupervised classification, or “ Clustering”, we enter the number of groups,
or “clusters,” we wish to have, and certain other specifications. The software then
examines the pixelsin the image and groups them according to similar spectral
characteristics. These groupings are not made on the basis of land cover, but on the
similarity of the spectral characteristics of the pixels.

As part of your preparation of aland cover map for your 15 km x 15 km
GLOBE Study Site, it is necessary for you to identify relatively large, homogeneous
areas in your image for ground study and later use in validating your completed land
cover map. To do this, you will have MultiSpec© cluster your image. Thiswill help you
locate areas to visit for ground verification studies.



Clustering

To demonstrate clustering, you will use the Beverly, Massachusetts (Beverly.lan) image
provided with your MultiSpec®© tutorial (See“A Beginning Note," page 1).

* Launch MultiSpec© and Open the Beverly.lan image. Thisisatypical 5 channel, 512
pixel x 512 pixel GLOBE Study Site image.

* From the Project menu, as shown below, select New Pr oj ect.

New Project

Open Project... 38
Close Project

5ave Project

5ave Project As...

Use original statistics
Use enhanced statistics

Clear Statistics
Change Base Image File...

Add As Associated Image

Y our clustering exercises are saved as “Projects’ and, when done, can be opened by
MultiSpec© as “ Thematic Images.”

» From the Processor menu, select Cluster. “Clustering” is MultiSpec©’ s terminology
for an Unsupervised Classification. As shown below, The Set Cluster Specifications
window opens. It isin thiswindow that you select a clustering “algorithm™ (method by
which the software carries out its clustering) and enter certain values for the software to
use.



Set Cluster Specifications

Algorithm Channels: [ All - |
2 Single Pass ...
C‘ISODATA...
Symbols: [ Default set v |

Cluster Classification Map Area(s)
() No classification map Cluster Stats: | To New Project "l
) Training Area(s)

# Image Area
Start  End Interval

[ Create cluster mask file

Write Cluster Report/Map To:

sy, LR 1 512 1 [+ Project Text Window
B column |1 512 1 [ Disk File
Classification threshold: [16 (cancer] [ ok |

* Firgt, click the Image Area button to place adot init.
* Click to place amarker in the Disk File box. This saves your project to disk.

« Lastly, click the ISODATA button, asindicated by the cursor in the diagram above.
ISODATA isthe algorithm, or mathematical process, that MultiSpec© will usein the
clustering process.



A new window, the Set ISODATA Cluster Specifications window will open, as shown
below.

S5et ISODATA Cluster Specifications

Initialization Options Other options
) Along first eigenvector Initial number clusters: |10
#® Within eigenvector volume Convergence {%a): 93.0
{3 Use one-pass clusters Minimum cluster size: 7]

Determine clusters from:
{7 Training Area(s)
# Image Area
Start End Interval
— Line 1 212 1

o’
= Column 4 512 |5 [ cancel |

It isin thiswindow that you tell MultiSpec© how you want the clustering to proceed.
The information you need to provideis:

* Be certain that the | mage Ar ea button is checked, as shown above.

» Select “Along first cov. eigenvector.” Thisisthe specific algorithm1 that
MultiSpec© will usein its clustering.

* Leave the settings in the Other options boxes unchanged for this exercise.

1. For adiscussion of MultiSpec©’s algorithms, see “An Introduction to MultiSpec©,”
by David Landgrebe and Larry Biehl, Purdue Research Foundation, 1995. This document
may be downloaded from the Purdue/LARS WWW site at:

http://dynamo.ecn.purdue/~Biehl/Multi Spec©



Notes: “Number of clusters’ tells the software how many different groups you wish for
the classification For thistutorial, we will use the default setting of 10. The number you
will use when you cluster your 512 x 512 image will be discussed later.

During the classification, the program goes through the data over and over. Thisiscalled
“iteration.” Each iterationiscaled a“pass."” The system makes “passes’ through the
image until a preset percentage of the pixelsin the image are not changed during the
pass. The clustering then ends. This percentage is called the “ Conver gence.”

“Minimum cluster size” tells the system the smallest sized area to work with.
Areas smaller than this minimum size will not be clustered.

* After you have made these settings, click OK

* The Set Cluster Specifications window appears again.

Set Cluster Specifications

Algorithm Channels: | All v |
i3 Single Pass ...
i ISODATA ...
Symbols: [ Default set v |

Cluster Classification Map Area(s)
() No classification map Cluster Stats: | To New Project "l
) Training Area(s)

#® Image Area
Start  End Interval
Line 1 512 1 B Project Text Window

[ Create cluster mask file

Write Cluster Report/Map To:

] -
= Column 1 512 1 EDISK File

Classification threshold: | 100 | cancel | 0K I

* In the lower left-hand corner of the box is the “ Classification threshold” entry box.
Changethevaluein thisbox to “ 100" just as you would change any item in aword-
Processor.

Setting this “threshold” value to 100 forces the system to assign every pixel in the image
to one of the clusters. A value of less than 100 specifies the tolerance for assignment of
pixels. A value of lessthan 100 will result in some pixels not being assigned to clusters.
In this clustering, you are interested in large, fairly homogeneous areas, so individual
pixels of slightly different spectral characteristics dotting the map are unnecessary.



* Click OK

» The Save Report/Map As dialog box appears, as shown below. There is adefault name
for your classified image file “Untitled Project.clu.” Leave the file name as Untitled
Project.cluster for this exercise. Do not use the name Beverly.clu, asthat will be used
for another file necessary for this tutorial.

|Fj] HultSpec. Tutorials

'@ Bever sub_clusier tiff
|___E.'_"| beverlydsubset.class [
[8] beueryDsubset madik ..
[s] beueryBsubset Project
[e] beusubfinal

o Shamrock?
LN
DesKtop

SAave Report/Map As:
IInTITIFI‘I I-'t'n_]F!I'T.I':III.'i:IHI'

Cancel

i &

* The system then makesiits first pass through the image to initially determine the clusters
present as shown in the Status box, below.



Status

Determining Initial Clusters (Covariance)

Line ¢ of 512

<

* The“Pass 1” clustering Status box then appears, as shown below. During thisinitia
iteration, Pass 1, the “ Percent of Pixels Not Changed” shows no value. Also note that a
timeis given for completion of this operation.

Satus

I5S00ATA Cluster - Fass 1.

Line: 144 of 512

Percent of pidels not changed:

Minutes until completion: 0.1

* The Percent of Pixels Not Changed entry does not change until the end of Pass 2.
During Pass 3, the value will be displayed, as shown below, along with atime to
completion of the pass.



Status

ISODATA Cluster = Pass 3.

Line: 1 of 512

Percent of pixels not changed: 85.7

k

Minutes until completion:

* During subsequent passes, the “Per centage of Pixels Not Changed” increases, until it
reaches the value given in the “Conver gence (%) specification." The time for each pass
to be completed is given in this window.

Y ou can expect the system to make several passes to achieve a 98% Convergence. The
time required for this process is dependent upon the processing speed of your computer.
On LC 11 (one of the oldest Macs you can run MultiSpec© on), you can expect the entire
process to take several minutes. On a G-3 machine, the process is done in afew seconds.

Note: If you press“Cancel” during a pass, you will be asked if you wish to cancel
immediately, or complete the iteration. Canceling immediately terminates the clustering,
while finishing the iteration ends the clustering at a Convergence less than initially
specified.

« After the clusters are determined, the system will display the “ Classifying Selected

Image Area”’ window, below. Here the system assigns individual image pixelsto the
clustersit has determined.
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Status

Classifying: Selected Image Area

Line: 25 of 512

Mumber of Clusters: 10

Minutes until completion: 0.5

11



* After the clustering is complete, you will see the Saving Statisticsin Project File
window, shown below.

Status

Saving Statistics in Project File.

Line: 291 of 101

Mumber of Clusters: 11

Minutes until completion: 0.0




« After the clustering process ends, the Untitled Project Window appears, as shown to
the below.

| =]

Untitled Project
CLASS LIST

| Edit Class Mame_. |

Stats:|Original -

[_Histogram Classes |
| List Classes Stats |
Update P Stats |

[—>Select || —>Coord. |
Classes
Cluster?2
Cluster3
Clusterd
Clusters
Clusterc
Cluster?
Cluster8

Cluster9
Cluster10

]

1]

e Close this window.

* When asked is you wish to "Save 'Untitled Project’ before closing?’, click Don't
Save.

It is not necessary to create or save a project for the Unsupervised Clustering. For this
work, we do not need to access the statistical information that is saved with a project.
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The Results of Clustering

There are two results of clustering:

A description of clustering activity and a“text map” inthe TEXT OUTPUT window,
A clustered Thematic image.

» From the Windows menu, select untitled project. Scroll to the top of this “text
window," and you will have statistics describing the clustering and its results. A part of
the text output for the sample clustering is shown below. In it are listed the number of
clusters produced and the average value (mean) of the pixel values for each band in each
of the classes.

Clustering completed after 6 passes and 929 of 52429 pixels changed.
Final cluster class statistics.
Cluster Pixels Channel Means

1 2 3 4 a
1 1247 114.6 132.5 114.8 216.8 220.0
2 (=IHCR 9.3 B85.3 259.4 221.3 160.35
3 BS5E 29.9 T1.1 42.32 1283.2 1323.4
4 a638 o4 V8.2 636 1446 11701
2 2761 120.9 120.9 106.9 160.6 151.4
B 22690 28.3 39.2 23.1 12.8 8.7
7 2245 Q5.2 3.9 557 22,7 19.4
=] 2372 162.4 147.6 139.1 116.2 127.3
a 1594 2053.2 182.8 182.3 122.0 154 .1
10 1243 243.5 245.6 243.32 134.4 184.6

Also produced is atext map of the clustered area. The system assigns a number or |etter
to each of the clusters, and then displays a map of the clustered area using this code. For
the clustered Beverly.lan image, the code is shown below.

Classes used:

Thresholded
Cluster 1
Cluster 2
Cluster 3
Cluster 4
Cluster o5
Cluster 6
Cluster 7
Cluster 2
Cluster 9
Cluster 1

DW=l m R W) R -
b o O B ) [ O T % P

—_

A portion of the Text Map from the Clustering process appears below. Each
number/letter represents a pixel and the clustered group to which it belongs. Y ou can see,
even from this representation, that the system has identified several large, homogeneous
areas, identified by the appearance of the same letter/number in an area.
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Untitled Projett =0—"—————————— ==

Clas=sification of Selected Aren
Lirnes 1 to 512 by 1. Columns 1 to 512 by 1.

2232332233344 555455885544 311121119911 112323334322232 15153333344 3233222 32333254 332333344 33322 2345
22IITIZ2IIISA45544558884591 1111158111 153433333333332 11153333334 33332 1232233344 33334 3333222222248
23F2333223344 3350045005554 11 11 11AASS1 115354 333333332 1 1 111433335333 3333 022222334444 53344 3332222223248 5
B3Z22EE2223443458545544555 1111 1444 155225544 3333333215 1115333333333 222 222333444 444443222 1532244442
FR2IZE222PEATE4ATE50044333551 11 1A4AD44 3333334333332 1151 1153233333333 33344 334 34 244 22 22233224455
2REI2REZ23ISA3255559842325559 144484444 333IIITIIITI 1S 111 11222333333 3223344 44443324215 1224 3324 444
2321022202223 332305 322222439 1945354444333333332 1 112 111 1122123334 32223333444 344444 2 1 13343224553
22Z2111199998543322545222333445 1 1 13455434 3333333211 11511 112211155441 1 1222233333344444 244333554555
22222 10AAAMNEZ 22222322254 32244 11234444334 323333311 113211 111123332211 1123452233344 444 33332044 53885

232 20AAAAAMADSSZEI 2SS IIIIAD4 34322333332 11 113 1010 112222314 1 12344455544 234 332225554 235855
2O5594AAAAANAADD 135534555222 53054 230544 3223333322 1154191 1 1132222 144449 13344544 3454 344 554 55322585
2004888 AAAAN AL 15354443501 1 135523234544 32233232323338954 191 11332 1222 1444445334554 444 22 3444558552555
2259888444 4044T 13355545555 193545044444 3222323322235 52 11 11221112121 14449 1333244532 1233444 55825595)

Z230AAAAMAAAAAN 10505430904 2544300400044 2232 22222003802 11 11 11 U1 111 T T 11 AAD 1 2225522255334 3322598580
15500AAAAAAAAAS 12500000023 344 34445444 3223323023344 534 1 11 1142 11 11 1T 1911 1 1151 122255233222 1188304
12450094A45404484 1112083 1233334544 5444 22233504 33323432 1 11 11423 11 T U TV DT TNAIS IS 122222222 2232258980
SO4009AAAAAAAAAAAAADDD D4 3333008545544 3554 354333345001 11 1142 11 1111111 11941 111233222444 23334558905
SO4000AAAAAAAAAAAAMADDS4 353300805054 5888534334 544455 1 11111111 1111155558 11 111123333444 34335590905
2444 325004AAAAAAAAMAA TS I 254333200054 5898544 325504450 1 11 11 1111 111 11325111 1 1111 1232233334355599550
44453224004 A005 040 AN DY 323333330455 044 855444 55985534 191 11521111 1444519911 1111 1122 123322335505388
3333344004008 AAMAMAADY 22 TI2APRAITEEE55000504 3444553 11111421111 1443519495 1111 1 1222333323335050880
BEZZZ2T000AAAAAAAAAMAADY 222222 PEAI320444 005 1158444534 1411211 195244455 1 1AA95 1111115332 133233505844
BEEZITIZITAAAD 1AAAAAAAD 1D233 3223335004444 58 1585405525 1111111 1854433555 19454 111 111233 1A03223235522
BEEZIFZEZATOOD00AD00AAAAAAR 222 PEATO084 334588044 5052030 1 11 1155 14444 2255558023511 111 1330AAZ223222212
23E2EEEATTTO0OADDSAAAAAADSZZ 2R ATE0004 23485044 444550 1 11195104444 32225552 1 130 1 111 1233553233545 11

5299533400 0AAAAAAAAAAAAAA 1222222554054 2244 5045844500 1 112200423344 222255322550 1 112233444 2244445112
DOAASIZA4TAAAAAAAAAAAAAD 1 1233322580040 500054 088444451 120000222332 22255 122444 1 1 D44444 32234445244

24 1052554 1 AdddbbAdbbbbd 405223325 1555545445855544559554555 1 1504 133211 15584333 11111 1543333334443443
444335 1540AAAAALAA DAY | 223325555084554555 2543585000400 1 14444 1232 1155444332 111111 154433334443422] |
44455554450444000054444 173322345 55550545555855285004005 154444 1 125045444433 111111111444323443 102 1) a
4445 15544350405500 15508523 3234455555554555550854 0440085500440 1 1 1 1024334443221 1111114432545 1445 1[5 ]
Giahi=lTnlul
||||I 1]
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Examining the Clustered Image

* From the File menu, select Open Image.

* Select the Untitled Project.cluster file name you used earlier, and click Open.

* The Set Thematic Display Specifications window opens, as shown below.
Y ou can experiment later with some of the other palettesin this menu, but for now accept

the default settings and press OK .

Y ou will note that thiswindow lists 11 classes. One of theseis called the “Thresholded”
class, and would normally contain pixels not included in the clustering process.
However, recall that you set the Threshold at 100, so thiswill be an “empty” class.

= 52t Thematic Display Specifications

[ Backgound color... ]| |

[+ Display legend

Start End Interval
gy LINE 1 512 1
“ Column |1 512 1
Palette: | Default Colors v |
Display:[ Classes w |
Display classes/groups: | All v |

Magnification

X(1.0

Mumber classes; 11
Mumber groups: 0

| Cancel I
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* Your clustered image opens as shown below.

(]

lasses
Thresholded
Cluster 1
B Cluster 2
B Cluster 3
B Cluster 4
B Clistar S
B Cluzter &
B Cluster 7
B Cluster &
W Cluster @
B Cluster 16

* Notice that there are 10 numbered classes, plus a class labeled “ Thresholded.”
This“Thresholded” class contains no pixels, because you set the “ Thresholding” value to
100, on page 6. Each classis assigned a color by the system which has nothing
whatsoever to do with what the cluster represents. The clusters are produced and arranged
in order of descending level of brightness. That is, clusters near the top of the list
represent surface materials that are “brighter’ (have greater reflectance) than those near
the bottom of thelist.

* You may print the image from the File menu. When you do, the clustering key will be
printed along with the image.

* You may use some of MultiSpec©’ s regular tools with this Thematic Map. Such tools
as. the Zoom feature, and the Show Selection Coor dinates, from the Options menu,
function normally. The New Selection Graph feature will show a plot with only one
piece of data. Thismap is no longer “multispectral.” Each pixel no longer contains data
for different LandSat bands, or channels. Each pixel contains only one value, which
identifies its cluster.

17



» The software incorporates the ability to change the color of each cluster’s “color chip”
to one appropriate to your scheme of land cover classification. This process will be
detailed later in thistutorial.

« If you do a clustering with alarger number of classes, you may not be able to see them
al inthe“Classes’ column. To scroll through this column:

« Move your cursor into the column
* Hold the mouse button down
 Drag to either the top or bottom of the column.

The classes will scroll up and down.

* You and your students will be preparing a thematic map from this clustered image in
which you identify some of the clustered areas by their actual land cover. To do this, you
may save the image as a TIFF file from the File menu. This process does not save the
clustering key, only the image areawill be saved. The TIFF file may then be brought into
any one of anumber of paint or draw programsto be “fancied up” as athematic map.

* If you wish to have an image that contains the clustering key, and can also be moved
into paint or draw programs you can capture the entire screen using one of avariety of
“screen capture” programs that are available in the public domain or as “ shareware.” Y ou
will want to examine the features of these to determine that they save “ captures’ in a
format that can be read by your paint/draw program.

18



How Valid Isthe Clustering Process?

It is necessary for you to be confident that this process of “unsupervised classification”
actually yields clusters that are related to land cover types. To this end, included with this
tutorial isafile named “beverly.clu." In your Unsupervised Clustering, you had the
computer produce "clusters" based on similarities in spectral characteristics among
pixels. InaSupervised Classification, the operator, who is familiar with the land cover
intheregion, first "trains’ the computer to recognize different land cover types. The
computer than classifies the image based on these known land cover types. The
Beverly.clu image contains this kind of information.

* Be certain your “Untitled.clu” image is open.
* From the File, select Open.
* Open the Beverly.clu image.

» At the Set Thematic Display Specifications screen, press OK.
» Theimage will open as shown below.

=5
[Classes
Thresholded
Cluster
B Cluster
B Cluster
Cluster
B Cluster
B Cluster
B Cluster
0 Cluster
M Cluster

e

B Cluster

BB

= oo~ 3Ll Pl =

=

—Jo] 1]

EEE T | [ 1] [X500] -

e
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Thisimage looks very much like your own clustered image, with no land cover
identification. However, in addition to the clusters (which MultiSpec®© calls*“ classes,”),
it also contains “group” information, which is the results of the supervised classification.

« From the Classes menu, as shown below, select Groups.

« Classes
Groups

Groups/Classes

LUSter 2
B Cluster 3 3

Cluster 4 L
B Cluster 5

The legend now displays information from the supervised classification.

O=———————————————————— Beverly.clu
[Groups bal : TG

0 deciduous fores g
grassland

W rised forest ke

B conifer forest 4

B residential

B woter bodies

B shallow water

B commercial

B industrial

B rocks/minerals

N = G

S | [ [ %500

* Resize the images and arrange them side-by-side on the screen. (See Appendix 1 for
directions.)

» Compare the areas identified in the supervised classification (the Beverly.clu image) to

the clusters produced by the system in your unsupervised clustering (the Untitled
Project.clu image.)
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Y ou should see that the unsupervised clustering provides, at least in this case, agood
indication of the locations of large areas of uniform land cover that could be investigated
for verification studies.

Renaming the Clusters

* Close the Beverly.clu image by selecting Close Window from the File Menu.

Y our unsupervised clustering produced clusters identified only by a number, and
arranged in order of decreasing brightness. Once you have identified the land cover for
each of these clusters, your Thematic Map display may be customized to show these
clusters either by name or by MUC identification code. Y ou can, in effect, produce two
different Thematic Maps on the same image; one in which each cluster isidentified by a
name (e.g. Ocean, Transportation) and the other by MUC designations (e.g. 72, 93.)

The secret to this process is that your Thematic Map can display both
“Groups’ and “Classes.” When it is produced, both “Groups’ and “Classes’ have the
same set of colors and labels. To seethis:

* Click on the Classes pull-down menu shown in the diagram below.

[Closses |
Thresholded
Cluster

B Cluster

B Cluster
Cluster

B Cluster

B Cluster

L R R o
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* The pull-down menu will show the choices illustrated below.

Classes
» Groups

LSter
B Cluster ¢
B Cluster 3

Cluster 4

* Select “ Groups/Classes.” Then immediately pull down the window again and select
“Groups.”

* You can now switch between “Groups” and “classes’ and, for now, you will see for
now that the information in each view isidentical.

Y ou might decide that the “Groups” will contain descriptive names, while “Classes’
contains MUC labels.

To changethe name of a cluster in either view, at any time:
* Double Click on the cluster name (for example, “Cluster 17)

» The Edit Thematic Class Name dialog box, as shown below, opens.

Edit Thematic Group Name

Cluster 1

|L‘am:EI| | 0K I

* You may now enter either a descriptive name or MUC identification number
for this class.
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» Once you enter a descriptive namein, say, “ Groups,” use the pull-down menu

to select “Classes’ and enter the corresponding MUC identification number for that same
Cluster.

The October 1998 rel ease of MultiSpec© PC will save both cluster and class information,
while older versions do not. If you are not using this version, you should visit the

Multi Spec© page at Purdue University to download it.

* From the File menu, select Save Thematic Group Info.

 From the Project menu, select Save

 Accept the default name, and click OK

Changing Cluster Colors

It is sometimes difficult to tell which color “chip” in the Classes column is associated
with a colored areain theimage. To match classes to their image areas:

» Place the cursor over any color box in the “Classes’ column.

» Hold down the Shift key: The cursor changesto an “eye,” as shown below over
cluster 5:

[Classes hd |
Thresholded
Cluster 1

B Cluster /2

B Cluster
Cluster

R Cluster

B Cluster

B Cluster

-] oL o

» While holding the shift key down, Depress the mouse button and the areas in the
image of that class will “blink,” or turn to white.
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To Changethe Color of a Cluster:

» Doubleclick on any cluster color chip.
* One of the Macintosh color windows opens, as shown below.

. select New Color. .
f—— Original:
— o o
CHYE Ficker 120 a9
g "i I =
Crayon Picker 1a0°
]
t— Hue Angle: |[301 |°®
HLE Ficker
Saturation: (99 (%
. - ; _ i Value: 100 | %
HEY Ficker = W] S0 100

» Depending upon the Operating System you are using on your Macintosh, you will one
of several different kinds of "Color Pickers." The present color isindicated by a small
"+" in the color wheel. A new color can be selected by clicking anywhere in the wheel.

The intensity of the color can be controlled by the "slider" beneath the color wheel. When
you are finished selecting color and intensity, click OK.

* If you are unfamiliar with Apples"Color Picker," consult your computer's User Manual
for assistance.

How Many ClustersDo | Use

Most regions the size of your 15 km x 15 km GLOBE Study Site do not generally contain
alarge number of different land cover types. When you first perform a clustering on your
512 x 512 image, use the same values as you used in thistutorial. Examine the resultsin
light of your knowledge of your own area. Do some fieldwork and look at the areas your
clustering suggests are fairly large and homogeneous. Compare your findings to the
MUC Classification System. Only if you feel that this clustering does not adequately
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represent the land covers in your area should you increase the number of clusters, and
then 12 to 14 clusters should be sufficient to do the job.

Reporting the Data

In order to report your data, you must make some “sense” out of the clusters determined
by this unsupervised process. Y ou can then relabel the clusters as what type of land cover
they represent. The process involves the following steps:

* Desk Verification

* Field Verification

» Completing the Accuracy Assessment for your land cover map *
* Renaming the Clusters

 Sending in your completed map.

(* Before you can submit your map to GLOBE, it is necessary for you and your students
to determine how accurately you identified your land cover elements. See the Accuracy
Assessment section of the Land Cover/Biometry module of your GLOBE Teachers
Guide)
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Desk Verification

This process involves your use of local maps (topographic, land cover, soil, political,
etc.), other local references (aeria photos, people, agencies, etc.) and the combined
experiences of both you and your students to identify some of the clusters produced by
MultiSpec©. Use whatever resources you can to identify them. Remember that your
identifications should correspond to the most detailed level of the MUC (Modified
UNESCO Classification) System available for that type of land cover.

Field Verification

If there are clusters that you cannot identify “from the desk,” you will have to go out into
the field to determine what they are. If aformal “field trip” is not possible, in all
probability someone lives near to or drives by that area and can do the identification.

A Note About Expectations, and a Caveat

When you proceed to the classification of your own 512 x 512 image, you will find the
appearance of your clustered image probably considerably different than this
demonstration. Certainly the nature, abundance and distribution of land cover typesin
your image will differ from those in the Beverly, Massachusetts area.

Asyou cluster your own image, you may find that specifying 10 clusters does not
discriminate between standing bodies of water, except perhaps between fresh and salt
water. In other words, lakes, ponds, rivers, etc. will probably all be clustered into the
same group, unless there are significant surface properties that might change their
reflectance (i.e., significant algal growth on the surface of afarm pond.)

Validating Your Results

Before submitting your classified land cover map, be certain to perform the Accuracy
Assessment Protocol found in the Land Cover/Biology section of your GLOBE
Teacher’s Guide.
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Submitting your results:

Once you have an unsupervised classification (clustering) that seems to adequately
represent your 15 x 15 GLOBE Study Site, your results will be submitted to the GLOBE
Map Archive, as described in your Teachers Guide.

» Make a copy of your clustered Thematic image onto a high-density floppy disk and
clearly label it with your school name, your name, and “ clustered image.”

* Using your favorite word processor, prepare afile with the following “metadata:”

Y our School Name

Your Name

School Address

Date your image was acquired*

The LandSat “path and row” datafor your image.*

Some information about yourself, your students, and some of your experiences in doing
your clustering.

*This data should be printed on the color prints of your GLOBE Study Site
provided to you by the GLOBE Program. From your word processors
options, save this data as atext file and place it on the same disk with your

 From your word processors options, save this data as atext file (or ASCII file) and
place it on the same disk with your completed Land cover map.

* Carefully package these materials and send them to:
GLOBE Student Data Archive
NOAA/NGDC E/CG 1

325 Broadway
Boulder, CO, USA 80303
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Appendix 1:
Viewing Two Images Side-by-Side in MultiSpec©: Macintosh

In MultiSpec©, you may simultaneously view two (or more) images or view the same
image in more than one band combination.

To view two images side-by-side:

* Open thefirst image in whatever band combination you wish.

» Place your cursor over the"Size Tab," at the lower right-hand corner of the image, as
shown below.

« Hold your mouse button down and dr ag the image size to one-half your screen size.
» From the File menu, select Open I mage.

 Select the next image and band combination you desire. Y ou may open adifferent
image, or the same image in a new band combination. This allows you to directly
compare the differences seen in two or more band combination.

» Again click on the Size Tab and resize this image to one-half screen.

« Click on the second image's grey Title Bar, at the top of the image, and drag the image
to the right-hand half of the screen.

« Within the constraints of your screen size and available memory, you may open as

many image windows as you wish. These may be different images, or the same image in
different band combinations.
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